Introduction Viewing Pictures “ Image Adjustment Other Features mm

Nikon

Capture NX-D Reference Manual rorversion 1.6.0

I Introduction LabelliNg cecueeeeerereieisereireieseiseiseisessssssssessessssasesns 17 I Other Features
What Capture NX-D Can Do for You........c.ccceerenuenee 2 Il:.rlote.ctlng AR sommmmmnsmzmmmnssssms 12 Cropping PiCTUIES......cevereereereeisessessesseessesssssssaenes 43
Image AdJUuStMENTS .......ceevereererreireeeisssssessisssssenes 4 WS e ! File FOrMat ....ceceeecreieinsssissssessssesssesssssssssssssssssnsens 45
The Capture NX-D WindOWw .........cccevureurrnnenreereenenens 5 I Image Adjustment BatCh ProCessing......neineneinsensiseessisssssssssnsnns 46
PalEEEES ..coueeeeerierirersesseisrise i ississsssesisenes e A - Printing PiCtUres......ocvveveeneererreeseeseississinees .48
ThE TOOIDAN ...t assssssasses 8 . e Edit zette """""" e R AWI """""""""""""""" i~ Printing Image Information ..........ccceeeeeevesennreneenns 49
The Status Bar ......veneeneereenseeseeeessensseesenns .10 V\)/(E,osgﬁ omp:;xflon ( e oo INAEX PriNS ouveeeeeeeeireeeisencesersesenssesssessessesssenaes 50
The MenU Bar....eneeseeneiseiseiseesssisesasenns .10 ) Ji2 EElEmEs | TEEES) sxmmmnmnmomnsns: = Opening NEF Images Created in Capture NX/
Picture Control (RAW IMages).......ccvvveereeseensaneenns 24
L . _ Capture NX 2 ... eeserissssisssssssssssssssssssssens 51
IV|eW|ng Pictures ToNE/TONE (DELAIN) uuceeeeeeeeeeeeeereeeeeeseeeeeeeeeesseesesenenens 27 Preferences ... 55
Viewi . TOOI BUTEONS ..cceeieeceeiseeseesesseiessssssssssesssesaes 28
IEWING PICTUIES ... 11 R s ds H .
Side-by-Side COmMParison........eveeeseeneeereerseenenns 14 Azmoylngs lIJSt ar:j . clratc E o L IMenu Guide
Justing >e ectg olors MENU GUIAE c.uceueeeeeeeenerceeereessenssenssesasesssesaeeases 56
I Filters (COlor CONLIOl POINES) uuuuenneveeeeeneeesevessssssesssssssssnnns 37
RALING it sisssisssisssssssssssesssssssssssssessssses 16 R g

Save where otherwise stated, illustrations are from Windows 10. Default camera and software settings are assumed.

The links at the top of each page can be used for chapter navigation. Click [ to return to this page.

[% Notices

« No part of the manuals associated with this product may be reproduced, transmitted, tran-
scribed, stored in a retrieval system, or translated into any language in any form, by any means,
without Nikon’s prior written permission.

- Nikon reserves the right to change the specifications of the hardware and software described in
these manuals at any time and without prior notice.

« Nikon will not be held liable for any damages resulting from the use of this product.

- While every effort has been made to ensure that the information in this manual is accurate and
complete, we would appreciate it were you to bring any errors or omissions to the attention of
the Nikon representative in your area (address provided separately).
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What Capture NX-D Can Do for You

Capture NX-D lets you fine-tune pictures by, for example, adjusting brightness Copy Adjustments
and hue, and can also be used to edit RAW images taken with Nikon digital cam-

i Save adjustments and apply them to other images (page 40) or copy them
eras and save them in other formats.

to other computers (page 42). Saved adjustments can be applied to multiple
images using batch processing (page 46).

Fine-Tune Pictures

With Capture NX-D, it’s easy to adjust such settings as brightness and white
balance (page 20). Certain settings, such as exposure compensation and
Picture Controls, are available only with RAW images.

w Recorded Settings

Save Pictures in Other Formats

Fine-tuned or processed RAW (NEF/NRW) images can be saved in JPEG or TIFF
formats for use in other applications (page 45).

» Recorded Settings

Capture NX-D Reference Manual 2
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What Capture NX-D Can Do for You

Color Control Points

Color control points (page 37) make it easy to brighten, darken, or modify
colors selectively, sparing you the hassle of masks and other hard-to-use editing
tools.

Color control points apply only to colors in a selected range. Color control points
apply only to the chosen point and to objects of similar color in the surrounding
area, leaving objects of other colors largely unaffected.

Original image A control point placed in the sky affects only
blues in the top left corner of the image, leav-
ing the trees and buildings largely unaffected.

Original image A control point placed on the yellow building
applies only to yellows in the surrounding
area.
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Adjusting the size of the area affected is
quick and easy. Achieving the same ef-
fect in other applications would require
careful and time-consuming selection
of the area affected. In Capture NX-D,
applying color control points to a spe-
cific area is quick and easy, as are later
adjustments to the size of the area af-
fected.

You can use as many control points as
you need. The more points you add, the
finer and more intuitive the editing.

The area of effect can be widened to apply to
the entire sky.
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Image Adjustments
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Capture NX-D stores image adjustments in a “sidecar” file, separate from the
original image data, that is updated automatically as settings are changed. Be-
cause changes to settings are stored separately from the original image data, the
original picture can be restored at any time with no drop in quality.

> |

Settings file

g/

Image data

Exposure compensation

4 Image Adjustments
Image adjustments are contained in settings files stored in a “NKSC_PARAM"folder in the same folder
as the original image. All changes will be lost if this folder or the settings file is deleted; similarly,
because the image and the settings file are linked via the file name, changes will be lost or applied
to another image if the files are renamed. Use the file management features in Capture NX-D or
ViewNX-i to rename, move, copy, or delete files or folders.

Image adjustments made using Capture NX-D are applied when the files are opened in ViewNX-i.

Capture NX-D Reference Manual

Image adjustments (settings file)

5 e '/;; y
Original image

Fine-tuning preview

Original image (preview)

Saving Images in Other Formats

When files are converted to JPEG or TIFF, a new file is created by applying the
adjustments in the settings file to the original image data. Converting files to
these formats allows the edited images to be viewed in software other than
Capture NX-D and ViewNX-i.

Settings

: " ¥ | Settmg s applied to original im-
Original image age to create new JPEG or TIFF file

4
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The Capture NX-D Window

U) q (1) Menu bar: Access the menus (page 10).
:’ (@ Toolbar: Choose a view and access image ad-
Open wih_prnt_ Convert ie justment tools (page 8).

(3) Folder palette: Select a folder to display its con-
tents in the image area (page 6).

(4) Image area: View the images in the current
folder.

(5) Selected image: Selected images are high-
lighted in gray, with images that have been
modified indicated by a i icon at the top left
corner of the thumbnail. Double-click to pre-
view (page 11).

=W for the selected image (page 6).
B (7)File & Camera Information/Edit/Retouch: View im-
age information in the file and camera infor-
mation palette, fine-tune images using the
tools in the edit palette, or switch to the re-
touch palette to use the auto retouch brush
or color control points (page 7).

g (®status bar: View information on the selected

image (page 10).

The Navigation Palette

A navigation (bird’s eye) palette (page 6) appears when a preview is displayed by double-clicking a thumbnail in the image area.

Capture NX-D Reference Manual 5
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Palettes
Capture NX-D offers the following palettes. The Histogram Palette

The histogram palette provides a constantly- Channel menu
The Folder Palette updated histogram for the selected thumbnail

or the image in the preview display. The histo-
gram shows the tone distribution for the color
channel selected in the channel menu. Choose
RGB to view overlapping distributions for the
red, green, and blue channels: tone ranges in
which the distributions for red and green over-
lap are shown in yellow, those in which red and
| blue overlap in magenta, those in which green
= B Pictures and blue overlap in cyan, and those in which all
L8 Jikon] three colors overlap in white.

The folder palette lists the folders in the com-
puter’s storage system. Click a folder to view
the images it contains in the image area or pre-
view display.

.. &
:

-
[+
B
[+
[+
u

Bl p— The Navigation (Bird’s Eye) Palette

The navigation palette is displayed above the
folder palette when you double-click a thumb-
nail to display a preview. To zoom the preview

in and out, click the [ and [& buttons, use the

slider, or enter the desired zoom ratio in the

The folder palette menu gives access to recent

folders. Frequently-used folders can be added C:\Usersluser\PicturesiNikon text box.
to and then accessed from this menu. Register fo Menu...
Organize Menu...
W C:\Usersiuser\Picturesiikon When the preview is zoomed in, the frame
C\Usersiuser\Pictures in th igati lett h th
Cc\Usersluser in the navigation palette shows the area cur-
Clear History rently displayed. Drag the frame to view other

1
Folder palette menu areas of the preview.

Palette Menus
To access the palette menu, click the triangle (&) at the top right corner of the palette. Select Undock
to open the palette in a floating window that can be moved freely about the display.

Capture NX-D Reference Manual 6
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Palettes
The File and Camera Information Palette The Edit Palette
The file and camera information palette lists File and camerainformation tab Use the tools in the edit palette to adjust the Edit tab Tool list

information on the image currently selected or
previewed in the image area, including expo-
sure, the model of camera used to record the
picture, and the date and time of recording.
The file and camera information palette can be
displayed in the position normally occupied
by the folder palette (page 6) by selecting
Dock to Left in the palette menu.

The File and Camera Information, Edit, and Retouch Palettes

File Info 1

File: DSC_0001.NEF
Date Created: 4/15/2018 7.47.53 PM
Date Modified: 11/19/2007 5:16:12 AM

File Size: 11.2MB
Image Size: L (4256 x 2832), FX
File Info 2
Date Shot: 1002512007 07:50:19.22

Time Zone anmiUTC, DST.OFF
Image Cuality: Lossless Compressed RA

Camera Info
Device: Mikon D3
Lens: 28-70mm fi2.8D

Focal Length: 28mm

Focus Mode: AF-S

AF-Area Mode: Single

VR

AF Fine Tune: QON(0)
Exposure

Aperture: 11

Shutter Speed 1/500s

Exposure Mod Programmed Auto
Exposure Con OEV

Exposure Tuni

Iatrix

Metering:

Use the tabs at the top left corner to switch between palettes.

Capture NX-D Reference Manual

image currently selected or previewed in the
image area. The tool list (page 20) offers
Exposure Compensation, White Balance,
Picture Control, and Tone/Tone (Detail) tools
thatcanbeaccessedvia pull-down menusorby
clicking the tool icon and adjusting settings in
the adjustments palette (page 20). Additional
tools can be accessed using the tool buttons
(page 21) at the bottom of the palette. The
adjustment manager tool (page 21) can be
used to copy adjustments to other images or
save current settings for later use. To reset all
tools and restore the image to the state it was
in when first opened in Capture NX-D, click the
revert button (note that any changes made to
JPEG and TIFF images in other applications
since they were last opened in Capture NX-D
will not be reset).

‘ Adjustment manager

zure Compensation

e

ctive D-Lighting

Unchanged

Adjustments palette

-Tool buttons Revert button
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The Toolbar

The Retouch Palette Use the toolbar to choose a view and access image adjustment tools.
The retouch palette contains the auto retouch Retouch tab

brush (page 36) and color control point o

(page 37) tools. s

AV ArY ,@ 7
® @ @ @ 56 D® ©100)02 13 14150612 1818 2022 @@
@ Back/Foward Select the folder before or after the current folder. —
@ Wr=g Folder Display a dialog where you can navigate to and open a folder. Page 6
® E View Mode Choose a view mode for the image area. Page 11

Changing the Appearance of the Toolbar
The appearance of the toolbar can be changed using the Customize Toolbar item in the Window
menu; the default setting is Large lcon and Text. For illustrative purposes, the illustration above
shows the toolbar with Large Icon selected and all icons active.

Large Icon and Text:
e m B PSS g @

NEF/NRW + JPEG | View Tool|  WB | Straighten  Crop  Rotate Retouch Brush Color Control Paint | ~

Large Icon:
9> O HDNRE PSAEFC & EBlxY YV EIES

Capture NX-D Reference Manual 8
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The Toolbar
- : View images side-by-side. Choose from Compare Before and - - Filter images by a variety of criteria, including rating, label, and
| Multi After Images and 2 Images. Page 14 @ \ lieting camera settings. Page 19
Apply current adjustments to the “before”image for use as a ref- S0 (lear Filterin End filtering and view all imaces o
® [E] Current erence when making further modifications. Page 14 @ ’ . d d
® 'H original Restore the “before” image to the state it was in before any ad- Page 14 Batch Process Status  View batch process status. Page 46
- justments were made. rage s
=4 H
If the folder contains images shot at image quality settings of 19 [Efs] Cancel Batch Process  Cancel batch processing. T
"RAW + JPEG", select this option to list the RAW and JPEG copies Page 11 View the current image or images in ViewNX-i. The images are
separately. 0 IFA viewnxi displayed in their current state including any changes made us- o
Access the fit, image viewer, zoom, and hand tools L 2 ing Capture NX-D and, in the case of NEF/NRW (RAW) images,
' ' ' ' without conversion to TIFF.
Click a point in the preview to adjust white balance so that the ] | | ) 7 Nikon Transfer 2 (if installed b 6
sampled point takes on a neutral gray color (gray point sample Page 23 ) i [0 mportimages using Nikon Transfer 2 (if installed). Page 26
tool). ® E Open with Open images in an application and format previously selected Page 54
Straighten images Page 33 P using the Open With Application option. rage>s
R — Print the image currently selected or previewed in the image
P Page 4
Crop images. Page 43 2 =g Print area. Page 48
Rotate images 90°. The direction of rotation can be selected by @ Ea) Convert Files Save images in JEEG or TIFF format. Adjustments are applied Page 45
@ (@] Rotate keeping the button pressed. — : before the image is saved. I
@ @ Retouch Brush Remove dust and scratches (auto retouch brush). Page 36
) Color Control Point Adjust colors and brightness using color control points. Page 37
@ Quick Filtering Filter images using the filter bar. Page 19

Capture NX-D Reference Manual



S02-03
ノート注釈
S02-03 : Marked

S02-03
ノート注釈
S02-03 : Marked


Introduction Viewing Pictures “ Image Adjustment Other Features mm

The Status Bar The Menu Bar

View information on the image selected or previewed in the image area. Access image adjustment tools or save images in other formats.

File(F) Edit(E) V Y Image(l) Adjust(A) Tool(T) W

File name The file name. ) File Convert files to other formats, run batch processes, and print and rename files.
@ m Zoom ratio The zoom ratio at which the preview is currently displayed. @ Edit Select, copy, paste, and delete images.
Color space The color space of the image in the preview display. (® View  Choose a view mode, adjust zoom, and sort and select images.
Image size The size (in pixels) of the image in the preview display. (@) Image Rotate, rate, and label images or display a grid or the focus point, shadows, or highlights.
Color value The colgr ofthg pixel under the cursor in the preview and (& Adjust  Copy, paste, save, and load image adjustment settings.
image viewer displays. (®) Tool  Accessimage adjustment tools.
Position in folder The position of the current image and the total number of (@) Window View and hide palettes.

images in the folder. Click |l or Iz to view otherimages. - - - - - - -
Help View online help. In Windows, this option also displays the current software version number.

Capture NX-D Reference Manual 10
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Viewing Pictures

Viewing Pictures

I )

Capture NX-D offers the following viewing options.

Thumbnails

At default settings, Capture NX-D lists the images in the current folder as thumb-
nails. Selected images are highlighted in gray.

Thumbnail Size
Use the slider above the image area to choose the thumbnail size.

Slider

Capture NX-D Reference Manual

Previews

To display a preview, double-click a thumbnail, or select a thumbnail and then
click the view mode button in the toolbar and select Preview.

NEFMNRW + IPEG

Returning to the Thumbnail View

To return to the thumbnail view, click the view mode button in the toolbar and m

select Thumbnail. _
=22 Thumbnail

=== IMage viewer
v [ Preview

LV
' Full Screen

Same Name, Different Extension
If the folder contains pairs of images with the same file names but different extensions (for example,
RAW and JPEG images recorded at image quality settings of “RAW + JPEG"), only one copy of each pair
will be displayed when NEF/NRW + JPEG is on. To view all images, turn NEF/NRW + JPEG off.

2 <SHC B XY VEE VoS
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Viewing Pictures

I )

Viewing Pictures

The Image Viewer

To preview the current image with thumbnails above, below, or to one side, click
the view mode button in the toolbar and select Image Viewer.

= Image Viewer

— Freview

(%]
% Full Screen

8 Copture NX-D  DSC_0001.NEF (

Thumbnail palette

bl e [

O V—'.q“":ﬁrjll:fj .
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Choosing the Location of the Preview and Thumbnail Palettes
The locations of the preview and thumbnail palettes can be selected from the palette menus.

Undock

Dock to Bottom
Dock to Left
Dock to Right
Close

Preview palette menu

Undock
Dockto Top
Dockto Left
Dock to Right
Close

Thumbnail palette menu

The image has been modified. B is displayed if the image has
been modified using Color Efex Pro.

® The image was shot at an image quality setting of “RAW + JPEG”.
® The image is in RAW (NEF/NRW) format.

@ Image label (page 17).

® The image is protected (page 18).

® Image rating (page 16).

@ Image file name.

The aperture (f-number), shutter speed, and ISO sensitivity at
which the image was recorded.

12
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Viewing Pictures

Viewing Images Full Screen Use the left and right arrow keys on the keyboard to view additional images.

To hide the menus, toolbar, and palettes and view the current image full screen,
click the view mode button in the toolbar and select Full Screen.

AR E 2SAFC @E XYY BIEN VM oS

22 Thumbnail

=2 Image Viewer
1 Benin

l < Full Screen

Compare before and after images 2 Images

To exit the full-screen display and return to the previous view, click the d button
or press the Esc key.

Capture NX-D Reference Manual 13
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Viewing Pictures

Side-by-Side Comparison

I )

To compare images, use the “multi” tool in the toolbar. Choose Compare Before and
After Images to compare before and after views of a single image, or 2 Images to
compare multiple images side-by-side. To exit the side-by-side comparison display,
select Single Preview.

Multi
R Y S EC @AY Y EIE Y

[l compare Before and After Images
[0 2 Images
SE 4Images

v Uil Single Preview

Compare Before and After Images

Compare before and after views of the current image.

Capture NX-D Reference Manual

m Updating the “Before” Image

To update the “before” image to reflect current image adjustments, click the
button in the toolbar. The “before” image can then be used as a reference for
subsequent changes to image adjustment settings.

m Restoring the “Before” Image

To restore the “before” image to its unadjusted state, click the [f§ button in the
toolbar. The “before” image will be restored to the state the image was in when
first opened in Capture NX-D (note that any changes made to JPEG and TIFF im-
ages in other applications since they were last opened in Capture NX-D will not
be reset).

14
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Viewing Pictures

e e v 4

Side-by-Side Comparison

“2 Images”

Compare images side-by-side. When either image is zoomed or scrolled, the
other will be zoomed or scrolled to match.

I8 Capture NX-D  DSC_0001.NEF ( 10.0%) E3

Quick Fitering ~

vion

mEE

o moooomall

L PEE

vl

4“2 Images”
Computers with at least 4 GB of memory and 64-bit operating systems EI B
offer a choice of two- and four-image displays. The “2 images” feature
on computers running 32-bit editions of Windows offers only a two-
image display.

BN

[i¥ compare Before and After Images
v 00 2 Images

og

EE 41mages

U] single Preview

Capture NX-D Reference Manual

When you click the “multi” button and select 2 Images, the currentimage will be
displayed on the left. To select images for display, click the desired preview box
and then click a thumbnail. Only images in the same folder can be selected for
side-by-side comparison.

The selected preview is highlighted in white. Image adjustments apply only to
the selected preview, as do the histogram and navigation palette displays.

No adjustment

Exposure compensation set to +1.0 EV

Comparing Images in the Preview Display
To open the images side-by-side in the preview display,
click the view mode button in the toolbar and select
Preview.
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Rating

Pictures can be assigned ratings of from [§ (no rating) to five stars. Ratings are assigned using the thumbnail rating icons or the Apply Ratings op-
- % tion in the Image menu.

B Copture Nx-D  DSC_000TNEF

1 Select pictures.

To select multiple pictures, keep the Ctrl key
(or on Mac computers, the Ff/command key)
pressed while clicking each image in turn. To se-
lect two pictures and all images between them,

(] click the pictures while pressing Shift.

To assign the picture a three-star rating,
click the third star from the left. The first
three stars will be highlighted in yellow.

I “Apply Ratings”
Selected files can also be rated using the Apply Ratings option in the Image menu.

Capture NX-D Reference Manual 16
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Filters

Labelling

e I I

To make pictures easier to sort and locate, you can assign them labels of from “0”
(no label) through “9”, each with its own unique color.

Capture NX-D Reference Manual

Labels are assigned using the thumbnail label icons or the Apply Labels option
in the Image menu.

1 Select pictures.

4 To select multiple pictures, keep the Ctrl key
(or on Mac computers, the $f/command key)
pressed while clicking each image in turn. To se-
lect two pictures and all images between them,
click the pictures while pressing Shift.

2| Click a label (@; in the case of unlabelled images, the label “0” only appears
when the cursor is over the picture) and choose a label of from “0” (no label)
through “9” ().

(@ Click a label.

I “Apply Labels”
Selected files can also be rated using the Apply Labels option in the Image menu.

17
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Protecting Pictures

e I I

Protect pictures from accidental deletion. Protected pictures cannot be deleted
or renamed.

I8 CaptureNX-D  DSC_0001.NEF

B

Editing Protected Pictures
Pictures can be edited even when protected. Image adjustments are saved in a separate “sidecar”file.

Capture NX-D Reference Manual

Protection can be added or removed using the thumbnail protect icons or the
Protect Files in the option in the Image menu.

1 Select pictures.

To select multiple pictures, keep the Ctrl key
(or on Mac computers, the Ff/command key)
pressed while clicking each image in turn. To se-
lect two pictures and all images between them,
click the pictures while pressing Shift.

To remove protection, click the protect (now ) icon again.

“Protect Files”

Files can also be protected or protection removed by selecting Protect or Unprotect for Protect
Files in the Image menu.

18
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Filtering

e I I

To filter pictures using criteria such as ratings, labels, and photo information,

click the | button in the toolbar.

A dialog will be displayed where you can select |# ite x
filters. Only pictures that match at least one of the | e crters
~Clan A

selected criteria will appear in the thumbnail list. & Otabel

|:| Orange (2)
~[Jvellow (3)
|:| Green (4)
~[cyan (5)
[8lue 8}
~[Purple (7}
[magenta i2)
-] Fink (%)
~[nene (0}
=[] Rating

|:| Not rated

Filters o

The options for the Model, Focal Length, Shutter Speed, E; .
F Number, and ISO Sensitivity filters are restricted to values |
found in the images in the current folder. Clear A

Capture NX-D Reference Manual

Quick Filtering
Use the B button to filter pictures using the toolbar.

Filter bar

2| Choose a filter or filters from the options in the filter bar.

Mok Ak khkk ¥

If you select multiple ratings, all pictures with ratings in the selected range will be dis-
played. For example, selecting ratings of three and five stars displays pictures with ratings
of three, four, and five stars.

Click &3 to view only protected images, [&] to view only unprotected
images.

Only pictures that match at Ieast one of

thumbnail list.

Viewing All Pictures
To cancel filtering and display all pictures in the current folder, click the [ button in the toolbar.

mE PSAC eEXY)TE VS &
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Introduction

The Edit Palette

e [ L 1

Most image adjustments are performed using
the edit palette, which consists of a tool list, an
adjustments palette, and tool buttons.

The Tool List

The tool list contains the items listed below.
All but Tone/Tone (Detail) apply exclusively to
RAW (NEF/NRW) images.

Exposure Compensation Page 22

. White Balance Page 23
Picture Control Page 24
EE Tone/Tone (Detail) Page 27

Settings for these tools can be selected from
the pull-down menus. Selecting Original re-
stores settings to the values in effect when
the image was first opened in Capture NX-D.
At other settings, a check (@] appears in the
box to the right of the pull-down menu, and
changes can be hidden by removing the check
from the box ().

Capture NX-D Reference Manual

| E

Tool list

+ Recorded Settings

+ Unchanged

Adjustment palette

The Adjustment Palette

Use the adjustment palette to make detailed adjustments. Clicking a tool button
or anicon in the tool list displays settings for the selected item.

M | Ef

{:} Recorded Settings

U“; lec -
e I i A

NE + e
e T I @ 4

e Compensation

w Unchanged

Tools that have been modified using the adjustment palette are identified by the
label Manual in the tool list pull-down menus.

20
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The Edit Palette

Tool Buttons The Adjustment Manager Tool

The following tools can be accessed using the
tool buttons at the bottom of the edit palette.

Use the adjustment manager tool to copy ad- Adjustment manager
justments to other images or save current set- |G

Note that some of these tools can be used only  [g=2 ecorded Settings. tings for later use (page 41). dit
with RAW (NEF/NRW) images; for information,
see the section for each tool. Recorded Settings
Recorded Settings
Noise Reduction Page 28
Camera.and Lens Page 29
Corrections --
LCH Page 31 % Noise Reduction L) m 4 I
ﬂ Straightc'en and Page 33 v  Recorded Settings L} Adjustments
Perspective Control o
= M Noise Reduction + Setftings
Umharp Mask Png% Method + Faster
Levels & Curves Page 35 Intensity

Copy All Adjustments
These tools are accessed by clicking the but-
tons and adjusting settings in the adjustment
palette. The buttons for tools that have been
modified from default values are highlighted
in yeIIow (e-g-, ) L Tool buttons Load Adjustments. ..

Save All Adjustments. ..

The Revert Button

Click the revert (“Revert to Original State”)
button to reset all tools and restore the im-
age to the state it was in when first opened in
Capture NX-D (note that any changes made
to JPEG and TIFF images in other applications
since they were last opened in Capture NX-D Revert button
will not be reset).

Fine-Tuning Multiple Images
Image adjustments apply simultane-
ously to all the images currently select-
ed in the thumbnail list.

Capture NX-D Reference Manual
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Exposure Compensation (RAW Images)

e e

Adjust overall exposure, making images lighter
or darker.

The pull-down menu in the tool list can be used to choose from values between
+1.0and -1.0 EV.

e \ﬁ/ 13
”’i"’ﬁe,. gt \*g-&& "

li /
N CEE
/ ’.rn i

SBEV
SUZEV
2BV
BV

ADL (Normal)

7 l'iv'.
+1.0EV | i ‘ ,’[’r lﬂ

Manual

Register Adjustments. ..

Edit Registered Adjustments. ..
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For values between +5.0 and -5.0 EV,
incremented in steps of 0.01 EV, use the
Exposure Compensation control in the image
adjustment palette.

Exposure Compensation

Exposure Compensation

Unch

The image adjustment palette also offers an Active D-Lighting menu that can
be used to bring out details in highlights and shadows.

b T

Normal

Extra high 5%

Active D-Lighting
Active D-Lighting is available only with RAW images taken using cameras that support Active
D-Lighting.
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White Balance (RAW Images)

Adjust white balance.

White balance can be fine-tuned using the [JwaiGIEE=Ert=
Color Temperature and Tint controls in the im-
age adjustment palette. Tint can be set to val-
ues between -12 and +12: choose lower val- [EEEIRCUEEIE
ues for less green and more magenta, higher
values for the opposite effect. The range of val-
ues available for Color Temperature vary with
the option selected for white balance.

Gray point sample tool

White balance can also be set by sampling the image: click the & (Gray Point
o 3 ® Recorded Settings Sample Tool) button and click anywhere in the image to sample a single pixel,
ncandescent or drag the cursor over the image to use the average color value for the selected
area. White balance for the entire image will be adjusted so that selected pixel
or area takes on a neutral gray color.

Direct Sunlight
Shade

Cloudy

IE‘ Fluorescent (3000K)

U [E Fluorescent (3700K)
Fluorescent (4200K)
Fluorescent (S000K)
Fluorescent (6500K)

well  Fluorescent (7200K)
High Celor Rendering Fluoresce...
High Celor Rendering Fluoresce...
High Celor Rendering Fluoresce...
High Celor Rendering Fluoresce...
High Celor Rendering Fluoresce...
Flazh
FL-G1

Incandes-
cent

il | - Ll - o
mpled White balance adjusted to give blues a gray
cast and the overall image a “warm” cast

LA Blue area sa

Sodium-vapor Lamps

Manual

Beninter Adinstmentz
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Picture Control (RAW Images)

Adjust Picture Control settings. Color Reproduction Process Color reproduction process

Choose from the options below. The Picture
Controls available vary with the option select-
ed.

« Latest Picture Control: Colors are processed using the latest Picture Controls. The
most recently-added Creative Picture Controls and parameters can be applied
to pictures taken with cameras that do not offer these options.

- Camera compatible: Colors are processed using the Picture Controls for the camera
that took the picture. Choose this option for color reproduction that matches
the look seen in the camera monitor.

The pull-down menu in the tool list offers a
choice of preset Picture Controls.

[50] Standard
[ML] Neutral
V1] Wivid
[MC] Monochrome
[PT] Portrait
[L5] Landscaps
[FL] Flat
Dream
Morning
Pop
Sunday
Somber
Dramatic
Silence
Bleached
Melancholic
Pure
Denim
Toy
Sepia “Latest Picture Control”
Blue In the case of pictures taken with cameras that support Color reproduction process
=== only the most recent Picture Controls, Latest picture
Quick sharp control and Camera compatible offer the same choice

. . . of Picture Control parameters. The color reproduction pro-
The controls in the image adjustment palette can be used to choose a color repro- P . P .
cess can also be selected using the Color Reproduction

duction process, perform quick adjustments to the selected control, or fine-tune Process (page 54) option in the “NEF (RAW) Processing”
individual Picture Control parameters. tab of the preferences dialog.

@ Picture Control

Capture NX-D Reference Manual 24
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Picture Control (RAW Images)

Picture Control Parameters

After choosing a color reproduction process
(page 24), choose a Picture Control and adjust
Picture Control parameters. The parameters avail-
able vary with the camera used and the color re-
production process and Picture Control selected.

Recent Picture Controls

« The parameters below are available when

Latest picture control is chosen as the color

reproduction process or if the picture was

taken with a camera that supports only the
most recent Picture Controls and only Cam-
era compatible can be selected. Fine-tune
settings using the sliders or select Auto to let

Capture NX-D adjust settings automatically

(note that Auto produces results that may

vary with exposure and the position and size

of the subject in the frame).

Quick sharp: Quickly adjust levels for balanced

Sharpening, Mid-range sharpening, and

Clarity, or select Auto to let the camera adjust

sharpening automatically. Except when Auto

is selected, you can also make manual adjust-

ments to the following individual parameters:

+Sharpening: Control the sharpness of details
and outlines.

«Mid-range sharpening: Adjust sharpness ac-
cording to the fineness of the patterns and
lines in mid-tones affected by Sharpening
and Clarity.

Capture NX-D Reference Manual

[ Picture Control

Quick sharp

. N - N .

_—

Sharpening

Wid-range sharpening

[ Auto

Saturation

. . . - A .

Hue

: [ Auto

« Clarity: Adjust overall sharpness and the sharpness of thicker outlines without
affecting brightness or dynamic range.

« Contrast: Adjust contrast. Choose lower values for less contrast, higher values
for more contrast.

« Brightness: Adjust brightness without losing detail in highlights and shadows.

- Saturation: Control the vividness of colors. Choose lower values for less satura-
tion, higher values for more saturation. This option is not available with the
Monochrome Picture Control.

« Hue: Adjust hue. This option is not available with the Monochrome Picture
Control.

« Filter Effect: Simulate the effects of color filters when using the Monochrome,
Sepia, Blue, Red, or Pink Picture Control.

» Toning: Choose a tint when using the Monochrome Picture Control.

« Adjust Saturation: Choose the saturation of the tint used with the Monochrome,
Charcoal, Graphite, Binary, and Carbon Picture Controls. Does not apply to
black-and-white images.

Click Reset to reset all sliders. Note that Contrast and Brightness can not be
adjusted for Picture Controls that use a custom curve.

Creative Picture Controls

An Effect level slider is displayed when a Creative Picture
Control such as Dream, Morning, or Pop is selected. Use
the slider to choose the effect level.

~ Creative Picture Control

~ Dream

Effect level
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Picture Control (RAW Images)

Earlier Picture Controls

If the color reproduction menu offers a choice between Latest picture control
and Camera compatible, the parameters listed below will be available when
Camera compatible is selected. Fine-tune settings using the sliders or select
Auto to let Capture NX-D adjust settings automatically (note that Auto produces
results that may vary with exposure and the position and size of the subject in
the frame).

« Quickadjust: Drag the slider left or right to mute
or heighten the effect of the selected Picture
Control. Quick adjust affects all Picture Con-
trol settings simultaneously and cancels any
changes made separately to the individual
parameters. It is not available with neutral,
flat, or monochrome Picture Controls.
Sharpening: Control the sharpness of outlines.
Choose higher values for more sharpening.
Clarity: Adjust clarity (this option is available
only with pictures taken using cameras that
support the Clarity parameter).

Contrast: Adjust contrast. Choose lower values
for less contrast, higher values for more con-
trast.

Brightness: Adjust brightness without losing
detail in highlights and shadows.

Saturation (non-monochrome only): Control the viv-
idness of colors. Choose lower values for less
saturation, higher values for more saturation.
+ Hue (non-monochrome only): Adjust hue. Hue

IE Picture Control

Camera compatible

Contrast

. N b - - N

[ Auto

Brightness

Saturation

. N b - - N

|:| Auto
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« Filter Effect (monochrome only): Simulate the effects of color filters on monochrome
photographs.

« Toning (monochrome only): Choose the tint used in monochrome photographs.

« Adjust Saturation (monochrome only): Choose the saturation of the tint used in mono-
chrome pictures. Does not apply to black-and-white images.

Click Reset to reset all sliders. Note that Contrast and Brightness can not be
adjusted for Picture Controls that use a custom curve.

The “AUTO” Picture Control
The parameters for the AUTO Picture Control can be set
values of from A-2 to A+2.

Sharpening
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Tone (Detail)

Tone/Tone (Detail)

Adjust overall brightness and contrast, or make adjustments that affect only

highlights and shadows.

Tone

Clicking the icon shown in the illustration dis-
plays the following controls in the image ad-
justment palette:

« Brightness: Adjust overall brightness. Choose
from values between -100 and +100: the
higher the value, the brighter the result.

« Contrast: Adjust overall contrast. Choose from
values between -100 and +100: the higher
the value, the greater the contrast.

- Saturation: Control the vividness of colors.
Choose from values between =100 and +100:
the higher the value, the more vivid (saturat-
ed) the result.

Capture NX-D Reference Manual

Brightness
-100

Contrast

-100
. . . . . . . . . .

Saturation

Clicking the icon shown in the illustration dis-
plays the following controls in the image ad-
justment palette:

- Highlight Protection: Preserve details in high-
lights. Values range from 0 to 100: choose
higher values to reduce brightness in high-
lights.

« Shadow Protection: Preserve details in shadows.
Values range from 0 to 100: choose higher
values to increase brightness in shadows.

« D-Lighting HS: Brighten shadows in backlit or
poorly-lit pictures or reduce loss of detail in
highlights. Higher values reduce the contrast
between shadows and highlights.

Recorded Settings

+) EV

4

e I (w2 I

E Tone (Detail)

Highlight Protection

Shadow Protection

-Lighting HS
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Use the tool buttons for access to tools not in the tool list.

Noise Reduction

Selecting this tool displays noise reduction
controls in the image adjustment palette (see
below). After enabling noise reduction by
placing a check in the Noise reduction check
box, adjust settings as described in this sec-
tion.

The options available for Method vary with
the camera used to create the current picture.
If the only option available is Camera compat-
ible, the remaining settings can be adjusted as
follows:

« Amount: Use the pull-down menu under
Method to choose the amount of noise re-
duction performed.

- Edge Noise Reduction (RAW images only): Make out-
lines more distinct by reducing the occur-
rence of noise artifacts around edges.

« Astro Noise Reduction (RAW images only): Reduce

Normal
High

Low
Off

the occurrence of randomly-spaced bright pixels in long exposures.
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If the Method menu is available, choose Faster
for faster processing or Better Quality 2013
(RAW images only) or Better Quality for more

Intensity ml Fastel

the following items: ' Better Qualty
o Better Quality 2013

« Intensity: Choose the noise reduction level
from values between 0 and 100. The higher
the value, the smoother the image and the
less visible the artifacts caused by image
“noise”.

Sharpness: Choosing high values for Intensity
may smooth the image to the point that
details are lost; this can be countered by in-
creasing Sharpness.

Edge Noise Reduction (RAW images only): Make out-
lines more distinct by reducing the occur-
rence of noise artifacts around edges.

Astro Noise Reduction (RAW images only): Reduce the
occurrence of randomly-spaced bright pixels
in long exposures.

Better Quality 2013

Better Quality 2013 excels in reducing color noise at short wavelengths and over evenly-colored
areas of the image. Selecting this option displays additional Luminance and Color items, allowing
Intensity and Sharpness to be adjusted separately for each of these parameters.
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Tool Buttons

Camera and Lens Corrections « Auto Distortion Control: This option uses the lens information recorded with pho-
tographs to reduce the barrel distortion associated with wide-angle lenses and
the pin-cushion distortion associated with telephoto lenses. Auto distortion
control can be turned on or off from the pull-down menu; if the photograph
was taken with an advanced camera with interchangeable lens fitted with a
waterproof lens, you will also be offered an On (underwater) option for reduc-
ing pin-cushion distortion in photos taken underwater.

Auto Red-Eye: Automatically detect and remove “red-eye”.

Vignette Control: Adjust for variations in peripheral illumination that occur with
some lenses. Choose from values between —100 and +200: the higher the val-
ue, the greater the increase in brightness at the edges of the image.

Diffraction compensation: Reduce diffraction in pictures taken at small apertures
(high f/-numbers).

PF Flare Control: Reduce ring flare, circular flare, and other flare effects caused by
bright light sources in the frame. Depending on the type and shape of the light
source, the desired effects may not be achieved, in which case you may wish to
remove the check from this option.

Fisheye: This option is available only with photos taken using AF DX Fisheye-
Nikkor 10.5mm f/2.8G ED, AF Fisheye-Nikkor 16mm f/2.8D, or AF-S Fisheye NIK-
KOR 8-15mm f/3.5-4.5E ED lenses.

Selecting this tool displays the following con-

trols in the image adjustment palette:

« Color Moiré Reduction (RAW images only): To reduce
color moiré (an image artifact visible where
regular patterns overlap), select thisitem and |[IEESEEETEEEEY
choose an option from the menu. il

- Image Dust Off (reqular- or large-size RAW images only):
Compare photos with reference data recorded
using the camera to mitigate the effect of dust
on the camera image sensor. Click Change...
to choose the NDF file containing the desired
data. For more information on recording
reference data, see the camera manual.

- Lateral Color Aberration: Reduce lateral color ab-
erration (colored fringes and halos) in RAW
images. At default settings, this option is not
applied to JPEG and TIFF images.

« Axial Color Aberration: Reduce blurred colors
caused by axial color aberration. Choose
from values between 0 and 100: the higher
the value, the greater the effect.

Dust off ref photo was taken at:

Capture NX-D Reference Manual 29
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m Image Dust Off
Follow the steps below to perform Image Dust Off.

1 Click Change.... If the current folder contains an Image Dust Off reference
file, a message will be displayed; proceed to Step 2. If no message is dis-
played, proceed to Step 3.

2| To perform Image Dust Off using the file in the current folder, select Yes.
Otherwise, select No and proceed to Step 3.

3| Select a reference file and click OK to perform Image Dust Off.

Image Dust Off

Dust changes position from day to day; if possible, use reference data recorded in the last 24 hours.
If the camera offers image sensor cleaning, use only data recorded after the most recent cleaning, as
cleaning can change the position of the dust. Image Dust Off is not available with NEF (RAW) images
recorded at an image size setting of Small.

m Fisheye

Select Fisheye to process photos taken with fisheye lenses so that they appear to
have been taken with a wide-angle rectilinear lens. An area at the center of the
image (circular fisheye lenses) or centered around lines drawn horizontally and
vertically through the center of the image (full-frame fisheye lenses) is cropped
to match the camera picture angle.

Full-frame fisheye Circular fisheye

Capture NX-D Reference Manual

The AF DX Fisheye-Nikkor 10.5mm f/2.8G ED and AF Fisheye-Nikkor 16mm f/2.8D
If Include areas without image data is se-
lected, the image will not be cropped; instead,
sections of the image will be bent. The bends
contain no image data and are filled with the
color selected in the Fill color menu.

out image data

Fill Calor:

The AF-S Fisheye NIKKOR 8-15mm f/3.5-4.5E ED

The Size of Crop slider controls the size of the
crop. The smaller the crop, the more the center
of the image will be enlarged. Choosing values
closer to 1 with full-frame fisheye images will
result in sections containing no image data,
which are filled with the color selected in the
Fill color menu.

The Distortion Control slider controls distor-
tion. High values curve the image outward,
while lower values curve it inward.
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LCH

The LCH color space models color using values
for lightness (a property similar but not identi-
cal to brightness or luminance), chroma (color
saturation), and hue. These parameters can
be accessed via the channel menu in the im-

age adjustment palette when the LCH tool is

selected. Color Lightness
Chroma

Hue

Recorded Settings

m Master Lightness

Adjust overall lightness without affecting

chroma or hue.

(D Auto Contrast: Increase contrast by setting
the white and black points to exclude
a set proportion of the brightest and
darkest pixels in the image.

(2) Add Anchor Point: Click this button and
then click the image in the preview pal-
ette to add a point to the curve corre-
sponding to the lightness of the pixel
under the cursor.

(3 Reset Current Channel: Reset the master
lightness curve to linear.

(@) Reset All Channel: Reset the master light-
ness, color lightness, chroma, and hue
curves to linear.

(5) White-point output-level slider: Choose the
maximum output level (white point).
() Histogram: The histogram shows how the pixels in the image are distributed
with respect to lightness. The horizontal axis corresponds to lightness (in the

range 0-255), the vertical axis to the number of pixels.

Capture NX-D Reference Manual

(7 Luminosity curve: The slope and shape of the curve determines the lightness of
the image in the corresponding portion of the tone range.

Black-point output-level slider: Choose the minimum output level (black point).

(9) Black-point input slider: Choose the minimum (black point) input level.

(0 Gamma: Choose the midpoint (gamma value).

1) White-point input slider: Choose the maximum (white point) input level.

m Color Lightness

Adjust the lightness of selected colors

without affecting chroma or hue. This can

be used, for example, to brighten the blue
of a dark skies.

(D Add Anchor Point: Click this button and
then click the image in the preview pal-
ette to add a point to the curve corre-
sponding to the value for the pixel un-
der the cursor. @ l

(@) Reset Current Channel: Reset the color light-
ness curve to linear.

(3) Reset All Channel: Reset the master light-
ness, color lightness, chroma, and hue
curves to linear.

@) Color lightness curve: Moving a point on
the curve upwards makes colors in
the affected portion of the color range @
brighter, while moving it downward makes the affected colors darker.

(&) Width slider: Adjust the width of the curve that passes through the selected
point, increasing or decreasing the range of colors affected by the change.
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m Chroma

Increase or decrease color saturation over

the entire image or a portion of the color

range, making colors more or less vivid.

(D Add Anchor Point: Click this button and
then click the image in the preview
palette to add a point to the curve cor-
responding to the chroma of the pixel
under the cursor.

(@ Reset Current Channel: Reset the chroma
curve to linear.

() Reset All Channel: Reset the master light-
ness, color lightness, chroma, and hue
curves to linear.

(@) Chroma curve: Moving a point on the
curve upwards makes colors in the af-
fected portion of the color range more
vivid, while moving it downward makes
the affected colors less vivid (grayer).

(5) Output slider: Increase or decrease the saturation of all colors in the image.

(8) Width slider: Adjust the width of the curve that passes through the selected
point, increasing or decreasing the range of colors affected by the change.

(@ Exclude Gray: Increasing chroma may make neutral colors (grays) seem over-
saturated. Select this option to increase chroma without affecting grays.
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m Hue

Map selected colors in the original (input)

image to a specific range of colors in the fi-

nal (output) image. One application might
be to deepen the colors in a pale blue sky.

(1) Add Anchor Point: Click this button and
then click the image in the preview pal-
ette to add a point to the curve corre-
sponding to the hue of the pixel under
the cursor.

(@) Reset Current Channel: Reset the hue curve
to linear.

(3) Reset All Channel: Reset the master light-
ness, color lightness, chroma, and hue
curves to linear.

@) Scale: Click to change the vertical scale
from 60 ° through 120 ° to 180 ° and
back again (in this case the degrees re-
fer to a 360 ° color wheel). Increasing the scale increases the range of hues
visible in the display, while decreasing the scale increases precision.

(5 Hue curve: Select a point on the curve that corresponds to the desired input
color and drag it up or down until it intersects with the desired output color.

() Output slider: Modify the hue of all colors in the image.

(7 Width slider: Adjust the width of the curve that passes through the selected
point, increasing or decreasing the range of colors affected by the change.
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Straighten and Perspective Control

Straighten pictures or correct for the effects of
perspective.

m Straighten

Straighten pictures by up to +10°. Choose
lower values to rotate the picture to the left, |[EEEEEEIEEEEEE:
higher values to rotate it to the right. To hide Manual

the effects of straightening, remove the check
from the Straighten checkbox. e
To straighten pictures manually, click the [
straighten tool in the image adjustment pal-
ette and drag the cursor parallel to a line in
the preview (this option can not be used with
thumbnails; page 11). The image will be ro-
tated by up to £10 ° to make the reference line
horizontal or vertical, and the degree of rota-
tion will be displayed in the text box in the im-
age adjustment window. Unless Include areas
without image data is selected, the image will automatically be cropped to re-
move any empty corners.

M Straighten

and cropped to remove empty corners
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m Include Areas Without Image Data
Select this option to fill empty corners with black.

Image rotated to make reference line horizontal
and with empty corners filled in black

m Perspective Control

Correct the effect of perspective on, for example, photos taken with the camera
angled up to frame a tall building. Perspective can be adjusted vertically and
horizontally by up to £20.

BT =

Vertical: 20 Horizontal: 20

m Show Grid

Select this option to display a grid. The
grid color and spacing can be selected in
the “View” tab of the preferences dialog
(page 53).
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Unsharp Mask (8) Radius: The greater the radius, the wider the edges in the sharpened image
will appear.

(7 Threshold: The limit at which sharpening will be applied. If the threshold is
zero, sharpening will apply to all pixels in the image. Increasing the threshold
increases the amount of contrast that must be present between pixels before
the mask will be applied, with the result that only more distinctly contrasting
edges will be affected.

Increase sharpness by making edges more dis-
tinct. The contrast of edges is increased while
other areas are left untouched.

(D Delete: Delete the currently-selected 1 Unsharp Mask
mask from the unsharp mask list.

(2 Move Up/Move Down: Move the currently-
selected mask up or down in the un-
sharp mask list. RGB 30% 5% 20

(3) Unsharp mask list: A list of unsharp masks,
identified by color channel, intensity,
halo width, and threshold (e.g., “Red,
50%, 10%, 0”). Masks apply in the order
listed; to change the order, use the up/
down buttons.

(@ Color: Choose the color channel to which
the unsharp mask applies.

(5 Intensity: The amount edge contrast will
be increased.
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Levels & Curves

Adjust contrast, tone (brightness), and color

balance. Adjustments can be made over the

entire image or to specific portions of the tone range (for example, the gamut of

a specific printer, monitor, or other output device), allowing enhancements to be

made without sacrificing detail.

(D Channel: The current color channel.

(@) Auto Contrast: Increase contrast by set-
ting the white and black points to ex-
clude a set proportion of the brightest
and darkest pixels in the image, creat-
ing a curve that makes optimal use of
the output tone range while preserv-
ing details in shadows and highlights.

(3) Set Black Point: Click this button and then
click the image in the preview palette
to set the black point for the red, green,
and blue channels to the value for the
pixel under the cursor.

(@) Set Neutral Point: Click this button and
then click the image in the preview pal-
ette to adjust gamma for the red, green,
and blue channels to equalize the RGB
values for the pixel under the cursor.

(5) Set White Point: Click this button and then click the image in the preview pal-
ette to set the white point for the red, green, and blue channels to the value
for the pixel under the cursor.

(8) Add Anchor Point: Click this button and then click the image in the preview area
to add a point to the curve corresponding to the value of the pixel under the
cursor.

(@) Reset Current Channel: Reset the curve for the current channel to linear.

e I M (@ s
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Reset All Channel: Reset all curves to linear.

(9) White-point output-level slider: Choose the maximum output level (white point).
Dragging the slider down lowers the brightness of the brightest pixels.

10 Histogram: The histogram shows how the pixels in the image are distributed
with respect to brightness. The horizontal axis corresponds to brightness (in
the range 0-255), the vertical axis to the number of pixels.

@D Tone curve: The slope and shape of the curve determines the brightness of the
image in the corresponding portion of the tone range.

(12 Black-point output-level slider: Choose the minimum output level (black point).
Dragging the slider up increases the brightness of the darkest pixels.

(3 Black-point input slider: Any pixels in the portion of the tone range to the left of
the black point are output at the minimum output level. Dragging the slider
to the right steepens the curve and enhances contrast but may cause loss of
details in shadows.

(4 Gamma: Dragging the slider to the left increases the brightness of mid-tones,
while dragging it to the right makes mid-tones darker.

(5 White-point input slider: Any pixels in the portion of the tone range to the right
of the white point are output at the maximum output level. Dragging the
slider to the left steepens the curve and enhances contrast but may cause
loss of details in highlights.

Sampling the Current Channel
By default, the black point, white point, add anchor point, and auto contrast controls respectively set
the black point, anchor points, white point, and contrast for all channels. To apply these controls only
to the current channel, press Ctrl (or on Mac computers, the option key) while clicking the control.
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Dust and scratches can be removed using the retouch brush tool.

anaE Y sgeloEx vy B VES 6

Brush Size

A brush larger than the defect you are attempting to correct may affect neighboring areas of the
image.

The Auto Retouch Brush

The retouch brush copies data from surrounding areas of the image automatically and pastes it over
the defect. It may not produce the desired results if defects are widespread, the tool is dragged a
long distance, or the affected is very large. The time required to complete processing varies with the
image.
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@ Keeping the mouse button pressed, drag the brush over the defect. The af-
fected area is shown by a translucent red line; continue until the defect is
completely covered.

The Retouch Palette

Clicking the &g button in the toolbar displays the retouch
palette. Select or deselect Auto Retouch Brush to show
or hide the effects of the retouch brush, or undo the ef-
fects of the brush by clicking Clear.
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Use the B tool in the toolbar to selectively brighten, darken, or modify colors.
Capture NX-D automatically chooses the area affected according to the place-
ment of the control point.

Color Control Points

When you place a color control point, Capture NX-D au- Control point
tomatically detects the color at the chosen point and
selects all similar colors in the surrounding area. The ef-
fect is controlled by sliders: a size slider controlling ex-
tent of the area selected and (at default settings) three
adjustment sliders for adjusting Brightness, Contrast,
and Saturation in the selected area. Sliders can be ad-
justed by dragging the handles (®) left or right or by
placing the mouse cursor over a handle and rotating
the scroll wheel. You can choose the adjustment sliders displayed from the color
model menu for the retouch palette Color Control Point tool (page 39).

Size slider

Y=

Adjustment sliders

[ Color Model
You can click the triangle at the bottom or top of
the sliders to switch between the current color
model (BCS, RGB, or HSB) and ALL.

Capture NX-D Reference Manual

Using Color Control Points

Follow the steps below to add and adjust color control points.

@ Click the B button to enter color control point mode (to exit color control
point mode, click the button again).

L L g o
1 T

[ 2] Click the image to add a color control
point and drag it to the area you want
to modify.

@ Adjust the size of the control point by
dragging the handle of the size slider
left or right: the longer the slider, the
greater the area affected. The effect ap-
plies to the area shown by a dotted line
and diminishes with the distance from
the control point.
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Adjusting Selected Colors (Color Control Points)

4| Drag the handles of the adjustment slid-
ers left or right to adjust the selected
color. The illustration shows the bright- |
ness slider being used to adjust the
brightness of the sky: the effect applies
only to the blue of the sky, leaving the
color of the building unaffected, and
diminishes with the distance from the
control point.

The size and adjustment sliders can be fine-tuned using the color control point tool in the
retouch palette.

5 Repeat Steps 2 through 4 to add color control points as needed.

Adding Control Points
The practical maximum for the number of control points that can be added to a single image is
about 100.

P4 Zoom
You cannot zoom in by double-clicking the preview image while color control point mode is in ef-

fect. Use the navigation palette (page 6) or the zoom commands in the View menu.
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The Color Control Point Tool

Color control points can be fine-tuned using the color control point tool in the

retouch palette.

(MB : This button performs the same
function same as the B button in the
toolbar. @

(2) Color control points: Select a control point
and use the check box to show or hide
it or the X button to delete it. To select
multiple control points, keep the Ctrl (or
on Mac computers, the 3/command) @
key pressed while clicking each control
pointin turn. @

ntrol Point

Brightness
-100

Contrast

Saturation

-100

Deselecting Control Points
To deselect the current color control point, click it while pressing the Ctrl (or on Mac computers, the
&g/command key) or choose Deselect in the Edit menu.
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Adjusting Selected Colors (Color Control Points)

(3) Show affected area: View the area affected
by the color control point. The area in
which the effects are most noticeable

is shown in white, unaffected areas in
black.

(@) Do not affect the area: Disable the adjustment sliders for the selected control
point and prevent changes to other control points affecting the colors in the
selected area. The size of the area protected can be adjusted using the size
slider.

() Color picker: Use a color picker to choose the target color for the selected con-
trol point. Objects affected by the control point will be converted to the se-
lected color.
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() Color model: Choose the type of adjustment sliders displayed with the selected

control point.

« BCS: Display sliders for Brightness, Contrast, and Saturation.

« RGB: Display sliders for Red, Green, and Blue.

« HSB: Display sliders for Hue, Saturation, and Brightness.

« ALL: Display sliders for Hue, Saturation, Brightness Contrast, Red, Green,
Blue, and Warmth.

(P size: Adjust the size of the selected control point.

Adjustment sliders: Use the sliders to make adjustments to colors in the area af-
fected by the selected control point. The sliders displayed vary with the color
model selected.

(9 Reset: Reset values for the selected slider to those in effect before any changes
were made.

Copying Color Control Points

Copy and paste can be used to create multiple
control points with the same size and type of ef-
fect. To copy a color control point, select it in the
preview display or retouch palette and use the
Copy and Paste commands in the Edit menu.
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Copying Adjustments
Image adjustments can be copied and applied to other pictures, speeding the 3| Enter a name for the new setting and click | regiser adgjustments x
process of enhancing pictures taken under similar conditions. OK. In this example, we have named the | [

Move Up

Move Down

setting +1.5.
Adding Adjustments to the Tool List

Current settings can be added to the menus in the tool list.

Delete

Rename

1 Select a tool from the tool list and adjust
settings in the adjustment palette. Here
we have set exposure compensation
(page 22) to +1.50.

The new setting is added to the pull-down
menu and can now be applied to other
Manual pictures. The same procedure can be used
Manual to added settings to the pull-down menu
in the retouch palette.

2| Select Register Adjustments from the
pull-down menu in the tool list.

+23 BV
+1/2ZEV
+13EV
0 EV
-3 EV
=12 EV
23 EV N -3 EV

A EV B -1EV

ADL (Normaly Hpos ADL (Normal)

3 W Manual

Register Adjustments. .. Manual

EQN HEQISTETEd AOJUSTMENTS. .

Register Adjustments. ..
Edit Registered Adjustments...

Active
g Selecting Edit Registered Adjustments from

the pull-down menu displays a dialog where you

can rename or delete previously-saved settings.
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Copying Adjustments

The Adjustment Manager Tool

The adjustment manager can be used to apply multiple adjustments simultane-

ously.

« Copy Updated Adjustments: Copy only modified
adjustments.

« Copy All Adjustments: Copy all adjustments.

- Paste Adjustments: Apply adjustments copied
using Copy Updated Adjustments or Copy
All Adjustments to the currently-selected
image or images.

« Save Updated Adjustments: Create a file contain-
ing only modified adjustments.

» Save All Adjustments: Save all adjustments.

« Load Adjustments: Select an adjustments file

saved using Save Updated Adjustments or

Save All Adjustments and apply it to the cur-

rently-selected image or images.

Register Updated Adjustments: Modified adjust-

ments are saved and added as an option to

the adjustment manager pull-down menu.

Register All Adjustments: All current adjustments

are saved and added as an option to the ad-

justment manager pull-down menu.

« Edit Registered Adjustments: Reorder, rename, or
delete adjustments previously added to the adjustment manager pull-down
menu.

+w Recorded Settings
Copy Updated Adjustments
Copy All Adjustments

Paste Adjustments

wdjustments...

Load Adjustments...

Register Updated Adjustments...

Edit Registered Adjustments. ..

el

Copying, Saving, and Adding Adjustments
Converting pictures to JPEG or TIFF format prevents any prior adjustments being copied, saved, or
added to the pull-down menu.

Capture NX-D Reference Manual

m Copying Adjustments to Other Pictures
Follow the steps below to copy adjustments and apply them to other images.

1 Adjust settings in the edit palette. Here we have set exposure compensation
(page 22) to -2 EV and selected the Vivid Picture Control (page 24).

+~ Manual

2| Click the adjustment manager [&] icon
and select Copy Updated Adjustments or
Copy All Adjustments from the options in
the adjustment palette. Here we have se-
lected Copy All Adjustments.

ﬂ* Adjustments

w Manual

Paste Adjustments

3| Select images. In this example, the selected image has already been ad-
justed using the exposure compensation (page 22) and white balance
(page 23) tools.
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Copying Adjustments

4| Click the adjustment manager [5]icon and [EsRemmess m Copying Adjustments to Other Computers
select Paste Adjustments from the op- |[EEEE—. The Save Updated Adjustments and Save All
tions in the adjustment palette. Adjustments options save image adjustments
to a file which can be copied to other computers. |-=x<
The adjustments can then be applied to selected
pictures on the other computers using Load
Adjustments. o

Copy Updated

The adjustments copied in Step 2 are applied to the images selected in

Step 3. Because we selected Copy All Adjustments in Step 2, exposure com- | ®Adding Adjustments to the Adjustment Manager
pensation changes to - EV while white balance reverts to Original. Use the Register Updated Adjustments and Register All Adjustments options

to add adjustments to the adjustment manager pull-down menu.

Register Adjustments X m EI"

A
Name Edit
Move Up o
poyelDov Recorded Settings

Manual

Delete m llzar Adiustments

Coeospove

IE m Manual

Rename

Register Updated Adjustments...
Register All Adjustments...

Had we selected Copy Updated Adjustments in Step 2, the exposure compensation and
Py Tp ) P P P Edit Registered Adjustments...

Picture Control for the selected image would have been set to the values selected in Step 1,
while white balance would have remained at the value selected in Step 3.

When adjustments are copied from RAW (NEF/NRW) to JPEG or TIFF images, exposure compensa-
tion, Picture Controls, and other settings that are available only with RAW images will not be applied.

Capture NX-D Reference Manual 42
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Cropping Pictures

To crop unwanted areas from images, click the [ button in the toolbar.

(D) Aspect Ratio

The crop aspect ratio. Choose Free Crop to select a crop with no fixed aspect ratio.

® Custom For custom aspect ratios not listed in the aspect ratio menu, select Custom and enter the
Aspect Ratio |desired aspect ratio.

(3) RotateCrop |Rotate the crop 90°.

@) Show Grid Display an evenly-spaced 3 x 3 grid inside the crop.

(5) ResetCrop |Reset the current crop.

(6 Cancel Cancel the current crop.

(@) ApplyRatio |Apply the current crop.
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@ Choose an aspect ratio in the crop palette (to select a free crop with no fixed
aspect ratio, choose Free Crop).

11:8.5 (Letter)
107

1.41:1 (A series)
1.41:1 (B series)
118

65

54

Photo Ratio

The aspect ratio can be changed after you have resized and positioned the crop.

@ Drag the cursor over the image to select the crop. The area outside the crop
is shown in gray.
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Other Features

Cropping Pictures

@ Drag the corners of the crop to resize it without changing the aspect ratio.

To reset the crop, click Reset Crop.

Double-click inside the crop or click the Apply Ratio button in the toolbar to
crop the image.
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W4 Crop
Crops are not applied to the original image data and can be changed at any time by clicking the
button in the toolbar. This also applies in the case of images cropped using ViewNX 2 or ViewNX-i.

Crops are applied when images are converted to JPEG or TIFF (page 45). When NEF/NRW (RAW) im-
ages cropped in Capture NX 2 are opened in Capture NX-D, the crop is treated as the entire image;
to select a crop that extends outside these bounds, click the revert button (page 21) to restore the
original image and then select the desired crop.
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File Format

Other Features

To save RAW (NEF/NRW) images in JPEG or TIFF format, click the i button in the
toolbar.

e EHTTHADNMNRE PSAC @B XYY EIEVY D

A dialog will be displayed where you can choose a file format and adjust such
settings as compression and image size. Click Start to copy the file or files in the
selected folder.

Convert Selected File *
G [File format: JPEG v] Number of files: 1
E=timated total zize: 1 MB
Imaage aualitv
Quality Good Quality v
I a5 [ .E-E-:-Z:"Zii-i-:']@
(PR
@ [] Resolution 300 | dpi | Embed ICC profie @
Image size
[ Specify size
@ Lang edge Shoart edge Limit
3044 | x 2001 pixel
Destination
@l Use source folder I [|:| Use source file narne]

Browse... 1 9)

| Edt..

(D) File format: Choose from JPEG, TIFF (8 Bit), and TIFF (16 Bit).

(@) Quality (JPEG only): Use the slider or pull-down menu to choose a value between
0 and 100. The higher the value, the lower the compression ratio and the
higher the image quality; the lower the value, the higher the compression
ratio and the smaller the file size.

Save in:| C\Users\user\Pictures

@[File name: | DSC_0001_00001 jpg
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(3) Use LZW compression(TIFF only): Compress TIFF files using “lossless” LZW compres-
sion.

[% LZW compression may sometimes increase file size when applied to 16-bit images.

(@) Resolution: Select this option to choose the output resolution.

(5) Embed 1CC profile: Select this option to embed the current color profile in the
image.

(B) Specify size: Select this option to resize pictures saved in the new format. The
new size can be entered in pixels, centimeters, or inches. When you enter a
value for either Long edge or Short edge, the remaining value will automati-
cally be adjusted to maintain the original aspect ratio.

(7) Use source folder: Save copies in the same folders as the originals.

Use source file name: Save copies under the same file names as the originals.
Two-digit numbers will automatically be added in ascending order to the file
names if files with the same names as the original already exist in the selected
folder.

(@) Saveiin: If Use source folder is not selected, click Browse... to select a destina-
tion folder.

@10 File name: If Use source file name is not selected, click Edit... to name the cop-
ies using selected prefixes, suffixes, and sequential numbering.
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Batch Processing

Other Features

The File > Run Batch Process option can be used to perform the same image
adjustments on all pictures in a selected folder and then export the processed
images in a selected file format. Batch processing options are shown below.

Batch Process *

Source folder

(=)

| h:\Users\user\Pictures\Niknn Browse...

Include subfolders

Adjustments
O Apply current adjustments

O Adjustments to apply:

()

Browse...

® Apply adjustments already in files

@ { File format: JPEG v ] Number of files: 15
Estimated total size: 55 MB
Imane aualib
pRLL LTI L
Quality Good Quality ~

(=)

=] ®
| | Embed ICC profile | @

Short edge Uit

42868 | = pixel

Output settings
Resolution 300 | dpi

Q)

Image size
Specify size
Long edoe

()

Destination
| Use source folder Use source file name

@: Save in:| C:\Users\user\Pictures Browse...

File name:| DSC_0001_00001 jpg | Edit...

(D) Source folder: Click Browse to choose a source folder. To include all images in
sub-folders under the selected folder, select Include subfolders.

(@) Adjustments: Select Apply current adjustments to process the images using
the adjustments for the current image. To apply adjustments previously
saved from the adjustment manager, choose Adjustments to apply and click
Browse to choose an adjustments file. To export the images in the selected
folder in another format without changing the settings currently selected for
each image, choose Apply adjustments already in files.
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(3 File format: Select the format in which the processed files will be saved. Choose
from JPEG, TIFF 8bit, and TIFF 16bit.

(@) Quality (JPEG only): Use the slider or pull-down menu to choose a value. The high-
er the value, the lower the compression ratio and the higher the image qual-
ity; the lower the value, the higher the compression ratio and the smaller the
file size.

() Use LZW compression (TIFF only): Compress TIFF files using “lossless” LZW compres-
sion.

[% LZW compression may sometimes increase file size when applied to 16-bit images.

() Resolution: Select this option to choose the output resolution.

(7) Embed ICC profile: Select this option to embed the current color profile in each
image.

(8) Specify size: Select this option to resize pictures saved in the new format. The
new size can be entered in pixels, centimeters, or inches. When you enter a
value for either Long edge or Short edge, the remaining value will automati-
cally be adjusted to maintain the original aspect ratio.

(9) Destination: Select Use source folder to save the processed files to the current
folder. To choose a different folder, remove the check from this option and
click Browse. To save the processed files under the same names as the origi-
nals, select Use source file name (if a file with the same name and extension
already exists in the current folder, the processed file will be renamed by add-
ing a number to the file name); to choose different names, remove the check
from this option and click Edit.
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Other Features

Batch Processing

8/ 15

D3C_0010.NEF
D3C_0011.NEF
DSC_0012.MEF

DSC_0013.JPG
DSC_0014.JPG
DSC_0015.JPG

D3SC_0001.NEF
D3C_0002.JPG
DSC_0003.0PG

DSC_0004.MEF
D3C_0005.MNEF
DSC_0006.MNEF

Clicking Start starts processing and displays a progress dialog. Progress can be
viewed in the Queued and Finished tabs.

DSC_0004_0000
DSC_0005_0000
DSC_0006_0000

Queued ‘ Finished
(D Source: A list of the files that are awaiting processing or have been processed.
(2) Automatically Show/Hide: Removing the check from this option hides the prog-
ress dialog. The progress dialog can be displayed by clicking the [E button in
the toolbar.

Ml EY”SAFC @EXYY
(3) Delete: Click to remove the file selected in the Queued tab from the queue, or
to delete the log for the file selected in the Finished tab.
(4) View folder: Open the destination folder in the operating system file browser.
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[% Color Efex Pro
If the source contains files modified using the Color Efex Pro plug-in for Capture NX 2 or Capture NX, a
message will be displayed and the images will not be processed.

File Conversion

If multiple files are selected when the B button in | comvertseectedfites %
the toolbar is used to export files in another format | ™eem L v|  Mumeeroffies ¢
. Estimated total size: 16 MB
(page 45), the files will be exported as a batch process. | imag qusiy
Adjust settings as described for items (3) through @ | ™ oo sy -
on page 46. I =
Output seftings
Resolution 300 | Embed ICC profile
Image size
Specify size
3044 pixel
Destination
¥ Use source folder Use source file name:
Save in:| C:\Users\user\Pictures\Nikon Browse
File name:| DSC_0001_00001.jpg | Edit...
Cancel
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Printing Pictures

Other Features

To print pictures on a printer connected to the computer, select the pictures and
choose Print in the File menu. The “Print” dialog will be displayed.

Print [ 1 images selected ] x

Print Type: Full Page. v
Printer Setup

Paper Letter

Printer Type: ket v
Print Priorty. Cuaity v
Copies: 112

Page Layout
Resize Image

N

[Ratsteto ft
] Crop imagesto ft

Background color White ~

= (@raft mode)
[] Specify color profie. Settings.

FisOupit canc

Adjust settings as described on the following page and click Print to print the
picture as shown in the preview.

Notes on Printing

To print to a JPEG file, click File Output.
The most recently-used settings are recalled when the print dialog is next displayed.
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The “Print” Dialog

« Full Page: Print one picture per page.
- Index Print: Print multiple images per page (page 50).

PrintType . ctandard Photo Sizes: Print pictures at a standard photo size. Capture NX-D automatically
chooses the number of pictures printed on each page.
Printer  Click Settings to choose the printer and paper size and adjust other printer settings.
T PrinterType Choose Inkjet when printing on an inkjet printer.
'E’ When printing NEF/NRW (RAW) pictures, choose Speed to use the preview data embed-
& | Print Priority ded in the image for faster printing, or Quality to use the original image data for higher
S quality output.
Copies Choose the number of copies of each page printed.
Rotate tofit Rotate pictures to print them at the largest possible size.
Cropimages Pictures are enlarged to fill the print area. Portions that do not fit in the print area are
to fit cropped out.
Baclc(glr:rnd Choose the background color. Choose White to print with no background.
Border width Choose the width of the borders printed around the image (the color of the borders varies
® with the background color). Choose 0 to print without borders.
< :
5 Copl-es of Choose the number of copies of each photo printed.
S eachimage
=
- Print . . . . .
Information Print the file name, date of recording, or photo information under each picture (page 49).
Use thumb- _ ) . . . . .
nail data Prlint using thgmbnall data. Images print l“aster,‘ but. at lower quality. Some images will print
e using the original file data even when this option is selected.
Specify color Click Settings... to select the color profile used for printing (Profile) and choose an
profile Intent from Perceptual and Relative colorimetric (page 52).
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Printing Image Information

Other Features

To choose the information printed under each picture, select Print Information
in the“Print”dialog (page 48), click Settings, and adjust the settings described on
the following page.

Prnt [ 1images selected | x

0 oo

Advanced Print Infermation Settings X

Date/Time Shot and Comment  Metadata Header / Footer

[] Date Shot

User Comment

Position:
O Inside Top Right
® Inside Bottom Right

O Outside Bottom Right

Font Settings:

Microsoft Sans Serif ~ | |Regular

R =

Sample

4/16/201

801:24:09.00

[¥% Print Information
Print information is not rotated when Rotate to fit is selected in the “Print” dialog. Metadata that
does not fit in the print area will be omitted.
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Advanced Print Information Settings

© | DateShot  Print the date of recording in the position selected for Position.
% Time Shot  Print the time of recording together with the date.
a User Comment Print the comment entered in the text box.
=4
B
E‘ Font Settings Choose the font, st-yle, foht poirlwlt size, a,r,md color used to print the date/time stamp. The
3 results can be previewed in the “Sample”area.
3
2
Choose the file and photo information printed with each picture. The font, style, and font
Metadata - . P N . : P "
point size can be selected in the “Font Settings”area and previewed in the “Sample”area.
Header Enter the text and choose the alignment for the header that will be printed at the top of
each page.
= Page Choose whether to print the page number and the total number of pages and select the
g Numgber position and alignment. The page number can be positioned at the page Top (in the
g header) or Bottom (in the footer).
§ Footer Enter the text and choose the alignment for the footer that will be printed at the bottom
= of each page.
Font Settings Choose a font, style, and font point size for the header, footer, and page number. The

results can be previewed in the “Sample”area.
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Index Prints
To print multiple images per page, select Index Print for “Print Type”in the “Print” | mImage Size
dialog (page 48). The options in the “Page Layout” area will change; choose the Pictures are printed at the size entered for“Width”and
number of pictures printed per page. “Height” (the minimum size is 20.0 mm x 20.0 mm
. and the maximum the same as the page size). The
= ) number of pictures per page is automatically adjust-
= ed according to the size selected.
Pictures printed at 50 mm x 50 mm
m Column and Row
Choose the number of columns and rows printed per
page (the minimum is 1 and the maximum 10). The
size of the pictures is automatically adjusted accord-
e ing to the options selected.
Layout
Choose a layout.
m Standard
Choose the number of pictures per page from a list m Images Per Page _ )
box. The size of the pictures is automatically adjusted Choose the number of images printed per page. The
according to the option selected images will automatically be resized according to the
number selected.
A2 x4 layout

An 8 x 8 layout

Margins

Choose the width of the margins.
Capture NX-D Reference Manual 50
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Opening NEF Images Created in Capture NX/Capture NX 2

Other Features

Images created with Capture NX or Capture NX 2
can be opened in Capture NX-D with image ad-
justment settings intact, allowing settings to
be further adjusted as desired. The settings
in the Capture NX “Enhancement Steps” or Manual
Capture NX 2 “Steps” section cannot, however, Manual
be adjusted separately, although they can be [l
hidden if necessary to achieve the desired re-
sult. To hide changes made using Capture NX
or Capture NX 2, click the B button in the edit
palette (page 7) to display the Versions tool
and deselect Apply adjustment steps.

Uil Ja A e

Exposure Compensation

E

Versions

The image below has been modified using the Picture Control tool in the
“Develop” section and the Gaussian Blur tool in the “Adjust” section of
Capture NX 2. Deselecting Apply adjustment steps in Capture NX-D hides only
the effects of the “Gaussian Blur” tool.

£

Apply adjustment steps: Ei

Apply adjustment steps: E
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m Unsupported Images

Imagesthathave been modified using the Color
Efex Pro plugin for Capture NX or Capture NX 2
can be fine-tuned in Capture NX-D by first re-
setting all changes using the revert button
in the edit palette (page 7). Pictures that
have been modified using Color Efex Pro are
indicated by [Bd icons in the thumbnail list.

o
s
]
e IT

=

Revert button

RAW (NEF/NRW) Images

Changes made to RAW (NEF/NRW) images in Capture NX-D, including those made using the revert but-
ton, are not reflected in Capture NX or Capture NX 2. RAW (NEF/NRW) images opened in Capture NX or
Capture NX 2 will be restored to the state they were in when they were last saved in these applications,
regardless of any changes made in the interim using Capture NX-D.

NEF Conversion
JPEG or TIFF images converted to NEF in Capture NX or Capture NX 2 are treated as JPEG or TIFF
images in Capture NX-D and can not be modified using options such as exposure compensation
(page 22) and white balance (page 23) that apply only to RAW (NEF/NRW) images.
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Preferences
To modify the default behavior of Capture NX-D, select Preferences... in the Edit Color Management
menu (or on Mac computers, the Capture NX-D menu).
Preferences X
General Color Matching Profile
c "‘ammm Default RGB color space: | Nikon SRGB 4.0.0.3002 ~
G e n e ra I \EIEer:::\:) P::;mg ® [] Use this instead of an embedded profile when opening images.
Open With Application
Dialog/Alert Printer Profile
Preferences x se this profile when printing
— 3T Profile; | No profile
:\‘:’;;"";:;m‘; - ®|IW|I @ Intzrt: [Percaptual
":;"‘(RAW) brocessing @ Maximum capacity: 2GB (Default) - ]
EE\E::‘;'VX'\‘::DDIICNDH @ [ Specify cache folder

Existing cache hancling Delete cache folder

Cache Iocation: Browse.

Cancel
(1) Default RGB color space: Choose the default RGB color space for image display.
@ e ) (2) Use this profile when printing: Select this option to choose a color profile for print-
ing from the Profile menu. Choose the Intent from Perceptual and Relative
(D Clear Cache: Clear the cache. colorimetric.
(2) Maximum capacity: Select a cache size.
() Specify cache folder: Select this option to choose a cache folder using the
Browse... button. Use the Existing cache handling menu to choose what to
do with the existing cache.
(@) Restore Defaults: Reset all items in the “General” tab to their default values.
W Intent

Perceptual maintains the relations between colors to produce results that seem natural to the hu-
man eye. The colors may however not be true to the original image data. Relative colorimetric

maps colors not in the selected profile to the nearest available color. All colors in the gamut of the
printer will be reproduced accurately.

Capture NX-D Reference Manual
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Other Features

Preferences

Levels & Sampling
Prefere X
General | evela & Curves
,,., @ l Auto-contrast ciip Black ‘ 0.50 ‘% White: | 0.50 |%]
Vi
NEF ( Samolina
Open With Appiication
Dialog/Alert Dropper sample size: Point sample v]
@ [ Restore Defauts ]
/

(D) Auto-contrast clip: The levels and curves auto contrast option (page 35) increases
contrast by setting the white and black points to exclude a set proportion of
the brightest and darkest pixels in the image. Choose the percentage of pix-
els excluded by the new Black and White points.

(2 Dropper sample size: Select the size of the area sampled by the gray point
(page 23) and levels and curves (page 35) sampling controls. Choose
from Point sample (a single pixel), 3x3 Average (the average of an area 3
pixels square) and 5x5 Average (the average of an area 5 pixels square).

(3) Restore Defaults: Reset all items in the “Levels & Sampling” tab to their default
values.
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View

Preferences

General Size of Text and Icon
Color Management ® Auio

Levels & Sampiing

@ O Standard (100%)
NEF (RAW) 9

Open With Appiication
Dialog/Alert

O Large (150%)

O Waximum (200%)
Grid 2
e
Color

@ Gridline every 1000 | pixels

‘ Subdivisions: 4

View Images @‘
®)

® Speed
‘ O Quality

[Mammummumbnan width (px):

@

(D) Size of Text and Icon: Choose the size of the letters and icons in the user interface.

(@) Color: Choose a color for the reference grid.

(3) Gridline every: Choose the grid spacing.

@) Subdivisions: Choose the number of subdivisions in each square.

() View Images: If Speed is selected, Capture NX-D will generate preview data as
modifications are made for faster preview updates, but some changes will
not be reflected in the thumbnail and navigation displays, and display quality
may drop when pictures are cropped.

(8) Maximum thumbnail width: Choose the maximum thumbnail width, in pixels
(page 11).

(7) Restore Defaults: Reset all items in the “View” tab to their default values.

Restore Defaults ]
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Viewing Pictures

Other Features

Preferences

NEF (RAW) Processing

General Color Space for Color Reproduction
Color Management

Recorded setting v

Sizes Medium/Small for NEF (RAW) Images

Perform recommended processing

‘ D1X RAW Default
6MP (3008 x 1960) ~

Color Reproduction Process

O Latest Picture Control

: ® Camera compatible

(D) Color Space for Color Reproduction: Choose the color space used for adjustments to
RAW (NEF/NRW) images.

(2) Sizes Medium/Small for NEF (RAW) Images: Select this option for optimal processing
when editing small and medium RAW (NEF/NRW) images.

(3) D1X RAW Default: Choose the default display size for RAW (NEF) photos taken
with the D1x. Choose from 6MP (3008 x 1960) and TOMP (4016 x 2616).

(@) Color Reproduction Process: Choose a color reproduction process (page 24).
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Open with Application

ces
General 'I \(* Open with Appiccation
Color Management

Levels & Samping Name Location Conversio

View
NEF (RAW) Processing

Dialog/Alert

clete
Folder to Place Open With File
@)

‘ CaUserslusenPictures

(1) Open With Application: Edit the list of applications that can be accessed via the
Open With option in the File menu (page 56) and choose the format (TIFF (16-
bit), TIFF (8-bit), or JPEG) used when images are opened in other applica-
tions.

() Folder to Place Open With file: Before being opened in other applications, images

are converted to the format selected using Open With Application. Use this
option to choose where the converted files are stored.
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Preferences
Dialog/Alert
Preferences X
E:\‘f';;";";g;gﬁg @ Reset "Dont show this dialog again® setting
(D) Dialog Windows: Click Reset to reset the “Don’t show this dialog again” check
boxes for all dialogs.
55
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Menu Guide

Menu Guide

The Capture NX-D Menu (Mac Only)
- About Capture NX-D: Display the product version

number. | About Capture NX-D
- Preferences: Open the Capture NX-D preferences
. Preferences... E:
dialog (page 52).
Services >

+ Quit Capture NX-D: Quit Capture NX-D.

Hide Capture NX-D 3H
Hide Others HH
Show All

Quit Capture NX-D  ¥Q

The File Menu

« New Folder: Create a new sub-folder in the
current folder.

« Rename Folder: Rename the current folder.

- Import images with Transfer: Launch Nikon
Transfer 2.

ri)
Mew Folder Cirl+M
Rename Folder

Import images with Transfer

Launch Camera Control Pro 2

Synchronize Edits
« Launch Camera Control Pro 2: Launch Open with ViewNX- Cirl+0
Camera Control Pro 2. Open With '

« Synchronize Edits: Select this option to ap- ShELEn

ply current settings to any images subse-

Launch Picture Control Utility 2

quently added to the current folder. Rename. w2
- Open with ViewNX-i: View the current image ~ ComvertFiles. SIS
. . . . . - Run Batch Process... Ctrl+B
orimages in ViewNX-i. The images are dis- = "o P
played in their current state including any Print._ Ciri+p
changes made using Capture NX-D and, in Exit Ctri+Q

the case of NEF/NRW (RAW) images, with-
out conversion to TIFF. This option is only available if ViewNX-i is installed.

« Open With: Open the current image in another application. Use the Open With
Application option to add applications to the menu (page 54).
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« Openin Explorer (Windows)/Show in Finder (Mac): Open the current folder in the operat-
ing system file browser.

« Launch Picture Control Utility 2: Launch Picture Control Utility 2.

+ Rename: Rename the current image.

« Convert Files: Convert the currently-selected image or images to JPEG or TIFF for-
mat (page 45).

« Run Batch Process: Perform batch processing (page 46).

« Page Setup: Adjust printer settings.

« Print: Print images (page 48).

« Exit (Windows only): Exit Capture NX-D.

The Edit Menu
« Undo: Undo the most recent operation. eqitce) ||
+ Redo: Redo an operation after performing Undo. Undao Ctrl+Z
+ Cut/Copy/Paste: Cut, copy, or paste the current selec- o A
. Cut Cirl+X
tion. Copy e
« Delete: Delete the current selection. Paste Ctri+v
« Select All: Select all images in the current folder. — —
« Select Inverse: Select all images in the current folder ~ SeledAl Clri+A
. Selectinverse  Cirl+Shift+A
that are not currently selected and deselect any im- S
ages that are currently selected. SelectFile v
« Deselect: Deselect all images. Preferences..  Ciri+K

- Select File: Select all files in the current folder that
match the criteria chosen in the Select File submenu.
« Preferences (Windows only): Open the Capture NX-D preferences dialog (page 52).
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Menu Guide
The View Menu The Image Menu
- Go: Navigate the folder hierarchy. viewt) [N | - NextImage/Previous Image: View the next or previ-  image() [ R
« Thumbnail/Image Viewer/Preview/Full Screen: = Ge b ous image in the current folder. Nextimage Right Arrow
. . ; . Previous Image Left Arrow
Choose how images are displayed ~ Thumbnail sl - Rotate: Rotate the current image 90 or 180 de-
v Image Viewer Alt+8 Rotate 90°CW Ctrl+R.
(page 11). Preview P grees. Rotate 90°CCW Cri+Shift+R
- Compare Before and After Images/2 Images/ Full Screen F Rotate 180°
4 Images: Compare images (r@ge 14). Compare Before and After Images Show Grid Ctrl+G
The 4 Images option is available only on =~ 2!mages Show Focus Point  Ctri+Shift+F
t ith a 64-bit ti } T Show Lost Highlights ~ Shift+H
a computerwi a it operating sys Thumbnail Size r Show Lost Shadows  Shift+3
tem and at least 4 GB of memory. T , e ,
« Thumbnail Size: Choose the thumbnail size Filter CHri+F Apply Ratings v
(@ge 1 ]). Zoom I Cirl++ Protect Files »
+ Sort Thumbnails by: Sort thumbnails. £oom Out el - Show Grid: Display a grid over the preview.
- Filter: Filter images by a variety of crite- ~ FittoScreen Clri+Alt=0
. . . View at 256%
ria, including rating, label, and camera = .0 oo CrleAlles
settings (page 19). View at 100% Cri+Alt+1
- Zoom In/Zoom Out/Fit to Screen/View at 25%/ ~ \iewat200%
View at 400%

View at 50%/View at 100%/View at 200%/View
at400%: Zoom the preview in or out.

« Show Focus Point: Show the focus point in the pre-
view display.
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« Show Lost Highlights: View areas of the image
with the maximum value for brightness and in
which details may have been lost to overexpo-
sure (“washed out”). A different color is used to
show the lost highlights for each of the RGB, red,
green, and blue channels.

Show Lost Shadows: View areas of the image with |
the minimum value for brightness and in which
details may have been lost to underexposure. A ‘%
different color is used to show the lost shadows LT 4&“?‘ \
for each of the RGB, red, green, and blue chan- - "’ii"«;;n / i - fﬁwﬁ*&#‘/ -
nels. ) - ,!; ESST T
« Apply Labels/Apply Ratings/Protect Files: Label (page 17), rate (page 16) or pro-
tect (page 18) selected images.

X
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Menu Guide
Menu Guide
The Adjust Menu
- Revert to Original State: Reset all image ad- |adusta) [
justments and restore the picture to its Revertto Original State Ctri+U
- Revert to Last Saved State Ctrl+Shift+U
original state.
. T Copy Updated Adjustments
« Revert to Last Saved State: Initialize the set- e ctrlShie
tings file (page 4), cancelling all chang- Paste Adjustments Chri+Shift+V
es made in Capture NX-D. Save Updated Adjustments
- Copy Updated Adjustments: Copy only modified =~ SaveAllAdiustments.. CUrShift+S
Load Adjustments. .. Clrl+3Shift+0

adjustments.

« Copy All Adjustments: Copy all adjustments.

- Paste Adjustments: Apply to the current image adjustments copied using Copy
Updated Adjustments or Copy All Adjustments.

- Save Updated Adjustments: Create a file containing only modified adjustments.

- Save All Adjustments: Save all adjustments to a file.

« Load Adjustments: Load adjustments from a file created with Save Updated
Adjustments or Save All Adjustments and apply them to the current image.

In the case of JPEG and TIFF images modified in Capture NX 2 or ViewNX 2, Revert to Original State
reverts the image to its last saved state.
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The Tool Menu The Window Menu
- Fit: Zoom the preview to fit the image area. Zoom is [TooicT) | N JNNME | - Histogram/Edit/Retouch/File & Camera Information/Bird’s  Windowtw) [N

Menu Guide

re-adjusted to fit the preview to the image area as ¥ Fit 3 Eye/Folders: View or hide the selected palette. v Histogram
. Combination Toal M Ny . v Edit Cirl+T
the size of the area changes. 2 00m Tool - « Show Tool Bar: View or hide the toolbar. + Retouch
« Combination Tool: Double-click the display to alternate- = Hand Tool H « Show Status Bar: View or hide the status bar. v File & Camera Information  Ctri+
ly zoom the preview to fit the image area and zoom GrayPointSample Tool W « Show Pallets: View or hide all palettes. v Birds Eye
Fold
to a 100% view. The preview can be scrolled by drag- g?'_’ ool c - Customize Toolbar: Customize the toolbar —
aighten Tool R w Show Toolbar
ging the cursor. Auto Retouch Brush Tool B (page 8). v Show Status Bar
« Zoom Tool: Click to zoom in. To zoom out, click while __GolerControl FointTool = A v Show Pallets Tab
pressing the Alt key (or on Mac computers, the Customize Toolbar s
option key). Use drag to zoom in on a selected area.
- Hand Tool: Drag to scroll the preview. The Help Menu
. ::iray.l;olrll.téampltehTooI: Se.t Wh(lte baf;)ce by sampling the preview (page 23). . Capture NX-D Help: View online help. S
» Hrop 100k £YOp INE Preview {page 2.3). « Check for Updates: Check for updates to Capture NX-D. Capture NX-DHelp ~ F1

« Straighten Tool: Straighten the image in the preview palette (page 33).
+ Auto Retouch Brush Tool: Remove dust and scratches (page 36).
« Color Control Point Tool: Selectively brighten, darken, or modify colors (page 37).

« About Capture NX-D (Windows only): Display the product ver- ~_ ©heckforUpdates
sion number. About Capture NX-D
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